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Introduction and Learning Objectives

Upon completing this course, you will have learned and be able to practice:

• Understanding desktop publisher’s role 
and key attributes 

• Locating all the key desktop publishing 
commands and functions in the 
Microsoft Word Ribbon

• Using the Ribbon, the Quick Access 
Toolbar, and keyboard shortcuts to save 
time on formatting and navigation

• Choosing a color palette
• Designing organized document 

templates and style sets
• Working with Microsoft Word’s 

automated tools to create reference 
tables

• Importing raw content from multiple 
sources into a single file

• Implementing document design
• Inserting and captioning graphics
• Formatting text into tables, and 

captioning tables
• Completing a production run
• Conducting white glove reviews, aka 

book checks
• Testing soft-copy collateral
• Packing and labeling hard copies for 

shipment or hand-delivery
• Preparing receipts
• Completing electronic submissions using 

Adobe Acrobat
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• How adults learn: 
• Understand WHY things work a certain way
• Participate in exercises
• Ask questions
• Relate the material to your own experience
• Take notes

• Bring up topics of interest to your job
• Move around during exercises

How to Maximize the Learning 
Process
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• Your Name and Position

• An interesting fact about your life 
or career 

• Your level of experience:
• Beginner, intermediate, high-level?

• What are you looking to get out of 
this training?

Introductions – Who is Who
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Module 1

INTRODUCTION

What makes a great desktop publisher
Customizing your virtual workspace 

with the Word Quick Access Toolbar
Tips and tricks to quickly navigate the 

document
Importing text with Paste Special
Introduction to the Word ribbon
Using Format Painter
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Characteristics of a Great Desktop 
Publisher

 Attention to detail, including editing glitches
 An eye for aesthetics
 Remaining cool-headed under pressure
 Understanding of composition and design
 Computer-savvy; Rather than panicking in the face of a 

mysterious formatting problem, ability to:
• Remain curious and interested
• Think the way the computer thinks about rendering 

a document
 Technical mastery of Microsoft Word and Adobe Acrobat 

Pro
 Ability to fix graphics issues in a pinch when a graphic 

artist is not available
 Understanding of the RFP and proposal constraints

Great desktop publishers have the patience of Job, are fast, and have great stamina 

Important requirement: Have the 
latest versions of software; reliable 
hardware; and previous versions of 
software installed on a separate 
computer (also used for CD-ROM 
checking)
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Introduction to the Class Project

 Open the document and get ready 
to practice all the steps as we go 
through the class

 Speak up if something doesn’t work

This is a learn-by-doing workshop, so we will get to format a proposal together

File Name: Volume I – Technical 
Proposal for Formatting.docx
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Using Commands in Microsoft 
Word

 Depending on how you like to work, 
Microsoft Word gives you three different 
ways of accomplishing the same tasks
1. If you are comfortable with Microsoft Word, 

use the functions the Ribbon functions as 
they’re laid out

2. If you’re like Sally from When Harry Met 
Sally, and you like to have things your way, 
build a Quick Access Toolbar of your most 
used commands

3. If you are an efficiency nut, memorize the 
keystroke shortcuts for all the DTP functions 
in Word (listed in your class materials)

Most professional DTPers use all three methods of working in Word
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Customizing your Quick Access 
Toolbar

 The Quick Access Toolbar is a special row of icons located 
above the Ribbon

 If you prefer, move it below the Ribbon by right-clicking on 
it and selecting Show Below the Ribbon  

 To populate the Quick Access Toolbar, go to the File tab, 
select Options, then go to the Customize tab in the Options 
dialogue

 In the drop-down menu, filter commands by popularity, the 
tab in which they appear, and even choose commands 
from tabs that are normally hidden

 This is a great place to put commands used often but which 
take multiple steps to find 

Accelerate your work by customizing your toolbar prior to starting
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Navigating Through the Document

 There are two efficient ways to move quickly through the document: 
Keyboard shortcuts and Navigation Pane

 To navigate word by word in the document, use the shortcuts Ctrl + 
or Ctrl + 

 To navigate paragraph by paragraph, use the shortcuts Ctrl +  or Ctrl 
+ 

 Double-click words to highlight individual words 

 Put your cursor at the beginning of a line, hold the shift key down, and 
click at the end of the line to select the whole line

 Ctrl + Click = Highlight Entire Sentence

 Ctrl + A = Select Entire Document or textbox text

 The Navigation Pane can be displayed by clicking the view tab and 
checking the Navigation Pane box in the show box, or press Ctrl + F

• You can search by objects like headings, graphics, or tables, or 
by advanced objects like field codes

• Browsing by heading or by graphic are effective methods of 
navigating the document
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Additional Ways of Navigating

 Zoom in and out of the 
document quickly to find 
the right locations:

• By using scroll bar on the 
right-hand bottom of the 
page

• By using Many pages view 
on the View Ribbon, Zoom 
button

Zooming in and out enables you to see the entire document in thumbnails, as if on a 
proposal wall – and click on the desired page, zooming in again

Left-click
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Selecting and Pasting Text

Text Selection and Pasting Shortcuts
Selecting a single word Place the cursor inside the 

word and double-click with the 
left mouse button.

Selecting a sentence Click once inside the sentence 
while holding down the Ctrl 
button

+

Selecting a paragraph at a time Hold down the Ctrl and Shift 
Buttons while pressing the up 
or down arrow

+ +

Selecting the entire document Press Ctrl and A + 

Using special paste options Press Ctrl and V together to 
paste the text, then click Ctrl to 
activate the Paste Special 
dropdown

+     

2

1Ctrl

Ctrl Shift /

Ctrl A

VCtrl
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More Keyboard Shortcuts

• If there’s a function you use regularly and want to learn the 
command, hover over it in the tab menus above and if there’s a 
keyboard shortcut for it, it will appear in the pop-up.

• Alt + Tab = See all open documents.
• Use Ctrl + Z to undo and Ctrl + Y to redo.
• Ctrl + C = Copy
• Ctrl + V = Paste
• Ctrl + S = Save
• Ctrl + P = Print 
• Ctrl + Q = Remove Bulleted/Numbered List Formatting 
• Ctrl + D = Font Dialog Box
• Ctrl + Shift + * = Show/Hide Paragraph Markers
• F4 = Repeat (typically used for formatting—e.g. if you just bolded 

text and want to bold another word or line, just click into the line 
or highlight it and press F4)



COPYRIGHT © 2019 
WWW.OSTGLOBALSOLUTIONS.COM

DESKTOP PUBLISHING FOR PROPOSAL PROFESSIONALS| 15

A Walk Through the Ribbon – File 
Tab

- Make sure only certain people can edit the 
document

- Strip out sensitive metadata such as document 
authorship

- Revert to an earlier version in case of a big boo-boo

- Find documents you 
just worked on

- Pin documents to 
the top of the list

- Start a new document using the Normal 
template or a custom template

- Create a new template from an existing 
one; can find one on the Internet too

Generate an Outlook 
email with the current 
document attached

The pins have disappeared 
in new Word, but you can 
hover over top of this area 
and you will see them
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Important Options in the Options 
Dialogue

- Show or hide spelling 
and grammar mistakes

- Customize 
AutoCorrect options 

- Change AutoSave 
frequency

- Set AutoRecover
directory

- Embed fonts

- Cut, copy, and paste options
- Create backups of local and 

remote work
- Detailed layout options
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A Walk Through the Ribbon – Home Tab

Use special paste commands

Paint selected formatting onto 
other text

Open the Font 
dialogue box

Adjust paragraph spacing; add 
spaces before or after 
paragraphs

Add borders to 
paragraphs

Open the 
Paragraph 
dialogue box 

Show/hide 
formatting marks –
CRUCIAL when 
troubleshooting a 
document

Select most used styles to appear in 
quick style area, for faster formatting

Open a list of all styles defined in the 
document

Use Find and Replace 
feature to implement 
repetitive fixes faster
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Using the Format Painter Tool

• Once you have a piece of text formatted 
the way you want, highlight the 
formatted text, including the line break 
marking 

• Click on the paintbrush, then select the 
text you want to paint with those 
attributes 

• To format multiple instances, leave 
Format Painter on by double-clicking the 
paintbrush, then click it to turn it off 
once you’re finished

• You can “borrow” formatting from other 
documents and transfer it to the one 
your are working on

The Format Painter tool is handy for quickly reproducing the format of a piece of text in 
other nearby areas of the document
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A Walk Through the Ribbon –
Insert Tab

Quickly insert a page break

Insert tables up to 
10x8; can also convert 
text to tables

Insert picture from file

Manage header 
and footer

Insert date and time; using an auto-
updating time stamp is not recommended

Insert special characters and symbols

Insert a focus box
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A Walk Through the Ribbon –
Layout & Design Tab

Change document theme

Change width of page margins

Insert page and section breaks

Place watermark on pages
Add page borders

Change indentation of paragraph

Change amount of space 
between paragraphs Set how text wraps around 

a graphic or table

Align and group objects on the page; this 
is especially helpful for graphics with 
captions
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A Walk Through the Ribbon –
References Tab

Create a Table of 
Contents for the 
document

Refresh Table of Contents; will update 
both header text and page numbers 
unless otherwise specified

Place a footnote in the document; 
rarely used but if a footnote is needed, 
it is required to be a proper one for 
Section 508 compliance

Inserts a caption beneath a 
graphic; very important if 
building a Table of Figures

Insert a Table of Figures auto-
generated by captions
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A Walk Through the Ribbon –
Review Tab

Check spelling and grammar, run 
readability statistics

Insert comment; useful for querying other 
team members working on the document

Turn track changes on 
and off

View document in original 
or final form, with or 
without changes tracked

View different types of changes, 
such as insertions or deletions, 
or formatting changes

Move between tracked 
changes, and accept or 
reject them Compare or 

combine the 
current document 
with another

Set permissions for 
who can edit the 
document



COPYRIGHT © 2019 
WWW.OSTGLOBALSOLUTIONS.COM

DESKTOP PUBLISHING FOR PROPOSAL PROFESSIONALS| 23

Creating the Template
Module 2

 Where to find compliance information in 
the RFP

 The elements of a proposal template
 How to choose a color palette and design a 

clean, attractive document
 Setting up front matter and creating 

sections within the file using breaks
 Setting up and using Word Styles
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Understanding and Incorporating 
RFP Requirements
 Read the Proposal Instructions or Section L very carefully for document design requirements
 The government will usually specify the front matter and many design elements you need to 

include in your proposal – typical requirements include:
• Reference tables, such as a table of contents, a table of figures, or a table of tables
• Information requirements for the cover page, such as solicitation number, offeror name and address, due 

date, and possibly signatures of senior leadership
• A specific legal disclaimer provided by the customer which must go either on the first page, or on every 

page
• Specific fonts and font sizes, page margins, paragraph spacing, single-sided or double-sided printing, and 

types and sizes of graphics

 It’s important to separate out individual front matter elements with section breaks
• Helps keep the document neat and organized
• Can allow you to modify headers and footers within individual sections; for example, you don’t want 

page numbers on your cover page, and you often might want to use Roman numerals for front matter 
and Arabic numerals for the body of the proposal
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Elements of a Proposal Template

 Considerations include:
• Is this a hard-copy or soft-copy submission?
• What do the RFP instructions say about 

typeface, font size, paragraph formatting, 
margins, graphics complexity, and 
information to include in the header/footer?

• Is the proposal in one- or two-column 
format?

• If the submission is hard-copy, does the RFP 
ask for single-sided or double-sided 
printing?

• How many levels deep does the outline go?
• How many volumes are there?
• Does the RFP call for appendices to the 

proposal?
• Will you need to include any 11”x17” 

foldouts?

A proposal template consists of the page layout, font/color choices, and header and 
footer design for the document
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Process for Creating the Document 
Template

1. Create a blank 
document

• Go to the File tab, 
click New, and 
select My 
Templates

• Click on Blank 
Document and 
click OK

• Select the 
Template radio 
button for a 
multi-volume 
proposal

2. Incorporate 
RFP requirements

• Set page margins 
at the minimum 
allowed by the 
RFP or 1”

• Adjust Normal
style, including 
typeface, font 
size, line spacing, 
and paragraph 
spacing

3. Lay out headers 
and footers

• Include all info 
required in the 
RFP

• Include legal 
disclaimer in the 
footer

• Add page 
numbers to 
footer

• Group 
information 
together logically

• Add top and 
bottom separator 
bars

4. Add visual 
appeal

• Set up color 
theme

• Set caption and 
heading styles

• Add graphical 
embellishments 
to the header 
and footer

• Look for ways to 
increase white 
(negative) space

Setting up 
document 
template 
takes an 
extra 30 
minutes 
upfront 
but saves 
hours 
later, 
when you 
need time 
the most



COPYRIGHT © 2019 
WWW.OSTGLOBALSOLUTIONS.COM

DESKTOP PUBLISHING FOR PROPOSAL PROFESSIONALS| 27

Consider the Design

Typography:
 Serif faces may be easier to read in 

continuous text than sans serif faces 
(Times New Roman)

 Sans serif fonts are best for graphics and 
headings (Arial, Arial Narrow for space 
purposes)

 All caps reduce reading speed by 13-20%

 Continuous italics type significantly 
reduces reading speed

 Underlining looks dated

 Readers pay attention to contrast among 
typographic elements such as bold, light, 
extra bold

To help evaluators not skip the important sections, you must visually structure the 
document so that the main ideas catch the readers’ attention
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 Use fewer fonts—one for text, one for 
headers, and another one for captions is 
plenty

 Use ragged-right or fully justified text 
appropriately

 Use centered text sparingly

 Use the alphabet-and-a-half rule to choose 
the right font size and decide whether you 
can wrap graphics or not 

 Minimize the use of all-caps – if you want 
the look of all-caps, use small-caps instead

More Design Considerations

Alphabet-and-a-half line length rule:
When inserting focus boxes and graphics 
and wrapping text, the alphabet-and-a-half 
rule places the ideal line length at 39 
characters regardless of type size. Measure 
the line length in inches or picas for your 
chosen body copy font using the alphabet-
and-a-half rule. This is one of the 
measurements you'll use in finding the ideal 
line length/column width for your proposal 
(if you have a choice, of course).

Lines of type that are too long or too short slow down reading and 
comprehension. Combine the wrong line length with the wrong type size and the 
problem is magnified. 

Lines of type that are too long or too short slow down 
reading and comprehension. Combine the wrong line 
length with the wrong type size and the problem is 
magnified. 

Lines of type that 
are too long or

Comprehension increase is important in evaluators’ ability to appreciate positive aspects 
of your proposal



COPYRIGHT © 2019 
WWW.OSTGLOBALSOLUTIONS.COM

DESKTOP PUBLISHING FOR PROPOSAL PROFESSIONALS| 29

Visual Hierarchy

 Heading 1 style should be 
larger, brighter, and more 
prominent than Heading 2, 
3, and so on 

 Indenting should be clear 
on bullets and sub-bullets

 The most important items 
on the page should be 
larger than the least 
important

 Important win themes, key 
words, or discriminators 
should stand out in focus 
boxes or pull-quotes

Ordering of images, headers, and text helps evaluators quickly understand relative 
importance of document’s elements and helps skim the document effectively
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Creating a Visually Appealing 
Document

 Fully-justified text is harder to read than left-justified, so try to 
avoid full justification if you can

 Use Word-recommended 1.15 spacing, at a minimum, within 
paragraphs, or 1.50 if you can afford it (old Word 2003 spacing is 
1)

 Add at least 6 pt spacing after each paragraph, to break up walls 
of text; using 12 pt spacing for 12 pt font, 10 pt spacing for 10 pt
font, is ideal

 Leave a space of at least the same point size as the size of the 
heading before it (12 pt for 12 pt, 14 pt for 14 pt), but keep it 
close to the following paragraph, so that the heading and text are 
grouped together attractively 

The more white space you can afford to include in your document, the more 
readable and appealing it will be Make sure your heading styles 

use a hanging indent instead 
of allowing second line to 
begin at the margin
Set bulleted and numbered 
lists apart from the rest of the 
text using indentation
 Indent bullets by at least 

¼” from body text on 
both sides
 Use hanging indents for 

multi-line bulleted or 
numbered text
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Layout Types

1 column  2 columns  ¾ columns
Every layout type 
has its advantages 
and disadvantages, 
and impacts 
readability and 
impression from 
your proposal
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Most Readable Formats

 Readers are most willing to read the ¾ 
page format with pictures and focus boxes 
in the margins

 Double-column text and single-column are 
no different in reader willingness, 
readability, and comprehension, as long as 
there are pictures

 Color + Graphics = Readability
 All important information should be 

presented at least 3 times for greater 
comprehension

Research results by Christine Menna, University of Pittsburgh at Jonestown, 2011
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Creating a Color Palette From an 
Existing Graphic

 Choose a source graphic – your logo or your customer’s 
logo, for example

• Note: Check with your graphic artist to make sure there is not 
already an existing palette

 Go to http://www.pictaculous.com

 Upload a picture from your hard drive and click on “Get My 
Palette”

 Copy down the six-digit codes under each color swatch –
these are the HTML hexadecimal codes

 Go to http://kuler.adobe.com, mouse over Color Rule, and 
select Custom

 Enter the six-digit codes from Pictaculous into the Hex 
fields on the Kuler page

 Copy the RGB values for each color – these are the 
numbers you will use to set your palette in Word

Color has a deep emotional impact on people

http://www.pictaculous.com/
http://kuler.adobe.com/
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Setting Up Your Color Palette as a 
Word Theme

 Remember that lighter and cooler colors 
are easier on the eyes than stronger or 
brighter colors – so go easy with the neon 
orange and use lots of muted blue or gray

 To set up your palette in Word, go to the 
Page Layout OR Design tab and select the 
Colors drop-down menu, then select Create 
New Theme Colors… OR Customize Colors…

 Next to each color category, use the drop-
down option to select Use Custom Color, 
then enter in your RGB values

 Check the preview of your theme to make
sure it looks nice

 Don’t forget to give your theme an 
informative name

So you have a nice five-color palette to work with – now what?
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Creating Compliant Front Matter

 Check how many separate items 
of front matter the RFP calls for

• Cover page? ToC? Table of 
figures? Glossary? Acronyms?

• Note: Reference tables may be combined into a single 
section

 Go to the Page Layout OR Layout ribbon, and under 
Page Setup, click on the Breaks drop-down menu

 Insert as many Next Page section breaks as there are 
pieces of front matter required

 When adding in front matter, make sure you enter text 
and objects above and to the left of the section break

 Make sure any legal language the RFP calls for is added 
to the cover page and body footer, as needed
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Making Placeholders for Reference 
Tables
 First, make your table of contents:

• Place your cursor above or to the left of the 
section break in the section immediately after
the cover page

• On the References tab, under Table of Contents, select the Table of 
Contents drop down menu and then choose Automatic Table 1

• Depending on how complex the structure of your proposal is, you 
may want to go to the Add Text drop-down next to the Table of 
Contents menu, and de-select Heading 3 – you only need to include 
it if your headers go four or more levels deep

 Add a Table of Figures and/or Table of Tables if needed:
• Either in the same section as the Table of Contents, 

or in the section following
• To get a Table of Figures or Table of Tables to generate correctly, 

you must use the Insert Caption command to create all captions in 
the document 
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Formatting the Document Using 
Breaks
 Word has 3 main types of document 

breaks:
• Page breaks are most useful for a piece of 

text that is not autoformatting nicely (not 
good for much else, so use sparingly) 

• Column breaks save space on bulleted lists, 
and smooth over awkward automatic text 
breaking in a two-column-formatted 
proposal

• Section breaks are a desktop publisher’s 
bread and butter—they let you:

• Change header and footer formatting from 
page to page

• Insert large and complex graphics without 
disturbing the flow of text

• Format parts of the same page differently 
• Use Roman numerals for front matter and 

special section page numbering for 
appendices, and so on
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Creating Polished Headers and Footers

 One of the marks of an 
excellent DTPer is knowing 
how to:

• Create mirrored 
headers and footers for 
proper double-sided 
printing

• Vary page numbering 
across document 
sections

• Format header and 
footer information in 
an aesthetically 
pleasing way

 To access the Header and 
Footer toolbar, double-click 
in the top or bottom margin 
of the page. The ribbon 
below will pop up:

NEVER use pre-generated headers 
and footers, or automatic parts 
other than page numbers

NEVER use clip art

Automated page numbers are 
essential to good desktop publishing

Company logos are often a good 
addition

Link to Previous is a key function – it 
allows you to change the content of 
headers and footers between 
sections of the document

If you are required to print double-
sided, using different odd and even 
header and footer designs will 
create a sleek look in production

Use this when you only need a cover 
page and no front matter

If you have narrow margins, use these 
options to save space
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Taking Advantage of Word Styles to Save 
Time and Make a More Robust Document

 Styles in Word are a DTPer’s key to 
enforcing consistency

 They save time on generating reference 
tables, and let you quickly implement 
changes across the entire document

 You can apply a style to a paragraph by 
placing the cursor in the text, and either 
selecting the style from the Quick Styles on 
the Home Ribbon, or by opening up the 
full list of styles and clicking on the name 
of the style

 Always apply formatting to text in a 
document as part of a defined style

The Normal style is the basic text style 
that Word uses in the document

It is the foundation for all or most of 
the other styles you define

• When removing formatting from 
a section of text, it reverts to the 
Normal style

• Be careful when changing the 
Normal style, as you may cause 
unintended effects such as text 
spreading out over the page limit, 
messing up tabulation, and so on
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Creating and Editing Styles in Word

 To create a new style in Word, 
create a section of text with the 
properties you want, then 
highlight it and right-click

 In the drop-down menu, select 
Save Selection as a New Quick 
Style…

 When you access the dialogue, 
you will have additional options 
to modify the new style

 Alternatively, you can open up 
the Styles pop-out menu and 
click on the New Style button

 To edit an existing style, you can 
right-click on it in the Quick Style 
Toolbar or the Style menu and 
select Modify
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Managing and Importing Styles, and 
Using Quick Styles
 Open the Styles menu, and 

click on the rightmost 
bottom button to open 
the Manage Styles window

 From here, import styles 
from a pre-existing 
template, clean up the list of styles, and 
select which styles appear in Quick Styles

 Display only the Normal style, the number of 
headings corresponding to the document outline, 
and a bulleted list style in Quick Styles for the 
authors and editors

 Remove anything you will never use
• This is critical when your company reuses the 

same templates repeatedly, as different styles 
get built up like dust bunnies under the sofa

• Having too many styles defined can lead to 
strange errors and mishaps 
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 To prevent the style 
sheet from becoming 
crammed with unused 
styles, set default paste 
to text only

• Under File → Options → 
Advanced →  Cut, copy, 
and paste → Change 
the first four options to 
Keep Text Only

 To delete an unused 
style, open the Styles
window, open the drop-
down menu for the style, 
and select Delete style

Cleaning Up Existing Style Sheets 
for Fast and Reliable Formatting
If you have been provided a template, de-cluttering styles 
early on will help keep the document clean

Right-
click
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Defining Table Styles

 Insert a 1 cell x 1 column table 
and place your cursor inside it to 
access the Table Design Ribbon

 Expand the quick table styles 
drop-down, and select New Table 
Style…

Give the table style a 
descriptive name

Apply formatting 
to different rows 
and columns

Change weight of 
borders

Choose which 
borders to apply

Cell fill color

Change text 
alignment

Advanced formatting options

Choose 
border style



COPYRIGHT © 2019 
WWW.OSTGLOBALSOLUTIONS.COM

DESKTOP PUBLISHING FOR PROPOSAL PROFESSIONALS| 44

Module 3

DESKTOP PUBLISHING THE PROPOSAL

 Importing raw text, tables, and 
graphics

 Implementing your document 
design

 How to handle graphics insertion
 Updating and debugging 

reference tables



COPYRIGHT © 2019 
WWW.OSTGLOBALSOLUTIONS.COM

DESKTOP PUBLISHING FOR PROPOSAL PROFESSIONALS| 45

Importing Content into a Clean 
Document

 Use the keyboard shortcut for pasting text only when importing large 
blocks of text from one document to another – Ctrl + V, Ctrl, T

• Use the same method when copying from a PDF – just be aware that text 
imported from PDFs has hard returns at the end of every line

 When pasting from Excel, highlight the range of cells you want to bring 
in, then press Ctrl + V to insert the content as an unformatted table

 When pasting from Powerpoint, make sure all your graphical elements 
are highlighted and grouped together

• Paste content as a picture – Ctrl + V, Ctrl, U – and place it inside a 1x1 table 
to make alignment easier and improve stability

Pasting from different programs requires different techniques to account for the quirks 
of moving data between programs
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Implementing the Document 
Design
 Go through the document and apply your template styles as 

needed
• You have already set the Normal style to match the government’s 

specifications
• Make sure you format headers at the appropriate level, as doing so 

is crucial for getting the Table of Contents to generate correctly
• If you see any paragraphs that break across pages with two or 

fewer lines of text on the previous or next page, open the 
Paragraph dialogue from the Home Ribbon, go to the Line and 
Page Breaks tab, and uncheck Widow/Orphan control

• If a header appears on the last line of a page, highlight them along 
with the first line of the body paragraph, and in the Line and Page 
Breaks tab check Keep with Next

 Apply table styles accordingly, adding in captions if the RFP calls 
for a table of tables

Make sure your bulleted lists 
are formatted correctly, and 
that if you have designed a last 
bullet style that it is applied to 
every final bullet in the 
document

To save space, you can place 
continuous section breaks 
before and after a bulleted list, 
place  your cursor inside the 
list, then click on the Columns
drop-down under the Page 
Layout tab and select Two
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Inserting Graphics Seamlessly Into 
the Document
 Before you insert a graphic, check to make 

sure that it is sized properly for the space 
allotted for it

• One of the biggest no-nos for a desktop 
publisher is manually resizing a graphic once 
it’s been pasted into Word – the proposal may 
be thrown out due to non-compliance on 
minimum font size in graphics

• If the graphic artist has rendered a picture that 
is way too big or small, ask them to resize it

 Insert each graphic into a 1x1 table
• Word handles placement on the page and text 

wrapping better with tables than with graphics 
• Tables eliminate problems with lines of text 

spreading out, or having the graphic jump all 
over the page when you move it

 Make sure that the graphic is placed inside 
the page margin

Use the auto-caption feature 
on every graphic, either by 
right-clicking and selecting 
Insert Caption from the drop-
down menu, or by clicking the 
Insert Caption button on the 
References Ribbon

If you move graphics around in 
the document, highlight the 
captions and press F9 to ensure 
the numbering stays in the 
correct order
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Adding and Formatting Focus 
Boxes

HEADLINE: 2-3 LINES EXPLAINING OR
SUMMARIZING THE BULLETS BELOW

 4-7 Bullets
 1-3 lines per bullet
 12 to 18 total lines
 Use parallel construction with 

all bullets supporting the 
headline

 Put together a focus box to go on first 
pages of your major sections (1.0, 1.1, 
1.2, 2.0, 2.1-2.6) 
 Should reflect major win themes for 

each section
 Key features and benefits of our 

solution, or statements of proof that 
we can do the job
 Use numbers to prove points – quantify 

and use specific names in the bullet
 Additional types of boxes: 

• What’s New
• Did You Know?
• Case Study

Focus boxes are one of the places for showcasing win themes and any information you 
want to highlight; they also break up the monotony of text



COPYRIGHT © 2019 
WWW.OSTGLOBALSOLUTIONS.COM

DESKTOP PUBLISHING FOR PROPOSAL PROFESSIONALS| 49

Formatting Tables

 To apply a style to a table, place your cursor inside the table and go to 
the Table Design Ribbon, then click on the picture of the correct style

• If you don’t see the style you want in the quick table styles top row, click on 
the downward arrow at the bottom right of the list to show all styles defined 
in the document 

 If your table is more than a page long, make the header row repeat on 
the next page by going to the Table Layout Ribbon and clicking on 
Repeat Header Rows, under Data

 Sometimes a table cell will contain a large amount of text, and will 
move the entire row to the next page instead of breaking in the middle 
– to prevent this, open the Table Properties, go to the Row tab, and 
select Allow row to break across pages

 Adjusting the width of columns, either by dragging the cell borders 
with the mouse or by manually defining column widths on the Table 
Layout Ribbon, will allow you to make the most efficient use of space
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Updating and Troubleshooting 
Reference Tables
 Once the document is fully formatted, go 

up to the front matter at the top of the 
document, right-click in each reference 
table, and select Update Table from the 
drop-down menu

 Carefully check each table for missing or 
duplicated numbers, broken page 
numbering, or other unsightly errors

 Ensure each table breaks neatly across 
pages, and doesn’t have widows, 
orphans, or blocks of white space 
between tables

 If using long narrative captions for your 
figures and tables, you may choose to 
just have the numbering and title in the 
reference table

• Be aware that you will have to remove this 
text every time you update the table
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 Have you applied the right heading styles to the correct headings 
and styles to text? Are any body paragraphs in a style other than 
Normal? Do you have any styles in the document that’s 
extraneous?

 Have you checked section number flow, and does it flow properly?
 Are any tables split? 
 Are any exhibits (graphics, tables) in the wrong color palette and 

need re-rendering or reformatting?
 Are all the exhibits in the latest versions? 
 Do exhibit numbers increment correctly? Are they all present, or 

are any missing?
 Are exhibit callouts introduced in the text prior to their 

appearance, near the exhibit?
 Do all exhibits have action captions, ending with a period at the 

end?
 Has the double-spacing after a sentence been changed globally to 

single spacing?

Do a Thorough Error Check Before 
Producing the Document
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Checklist (Continued)
 Is the spacing correct and consistent between paragraphs and 

sections?
 Are there any sections starting at the bottom of the page, with a 

heading alone?
 Do all bulleted lists use the same bullets and indentation?
 Are all headers and footers extended to fit landscaped pages?
 If the requirement is to print double-sided, are the mirrored 

headers and footers generated correctly, so that page numbers sit 
at the outside margin?

 Do page numbers in the document increment correctly across 
section breaks?

 Is the page size back to normal in the section after a pullout?
 Has the document been spell-checked and edited?
 If you have converted the document to PDF, does it look the way it 

should or are there noticeable differences from the Word file?
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Module 4
PRODUCTION AND SHIPPING

 Printing and binding a hard-copy 
proposal

 Verifying soft copies on CD, thumb 
drive, or other storage media

 Preparing PDFs for electronic 
submission

 Submitting a proposal 
electronically

 Shipping or hand-delivering the 
proposal
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Printing and Binding a Hard-Copy 
Proposal
 Always allow at least half a day 

to a full day for production
• Length of time needed varies 

based on length of proposal, 
number of copies needed, and 
type of printer being used

• If you do not have the capacity 
in-house to print and guillotine 
inserts for the front and spine of 
each binder, you will need to go 
to a print shop to have it done

 Check to make sure that soft 
copies on CD or thumb drive 
load and open correctly on a 
computer other than yours
 Always print an archival copy of 

the proposal for your own 
records

White Glove

Upon printing and binding your 
proposal, you need to round up 2-5 
volunteers to go through and do a 
White Glove Review.

White glove reviews involve a team 
of people paging through multiple 
copies of the same volume 
together, looking for errors, 
misprints, blank pages inserted by 
the printer, or missing pages.

Usually, the person who owns the 
proposal will call out page numbers, 
so the others can verify that all 
copies were correctly produced.
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Prepping the Electronic Submission

o Begin by saving all relevant 
Word documents as PDFs using 
the Save As PDF command in 
the File tab in Word

o Open your copy of Adobe 
Acrobat Pro, and select 
Combine Files into PDF
o The following dialogue will 

pop up:

- Add files in the exact order in 
which they should appear

- If you need to insert a divider 
page in the middle of an existing 
PDF or remove a page, use the 
Insert and Delete commands 
under Tools once you have 
created the combined file You can also combine a range of 

pages from within an individual 
file into the final PDF

Choose the 
smallest file size, to 
make sure you 
don’t overload the 
server during the 
submission process

Once everything is in 
order, click on 
Combine Files to 
create the final PDF



COPYRIGHT © 2019 
WWW.OSTGLOBALSOLUTIONS.COM

DESKTOP PUBLISHING FOR PROPOSAL PROFESSIONALS| 56

Completing an Electronic 
Submission
 Read through each file, page by page, checking for any mis-

inserted or missing pages, showstopper errors caused by 
converting the file from docx to PDF, or any other irregularities
 Electronic submissions are easier in that they require less time to 

produce and fewer contingency plans, but…
• They are harder because it’s much easier for a large mistake to go by 

unnoticed
 NEVER wait until the last day to complete an electronic 

submission
• Yes, almost all of us have done it – but it’s miserable and stressful for 

everyone
 Triple-check your attachments before submitting your proposal
 Do not assume your proposal has gone through unless you 

receive confirmation from the government
• Check delivery and read receipt options; if you submitted but haven’t 

heard anything, give your govie a call
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Preparing the Proposal for Hand-
Delivery 
 The government provides the correct 

shipping address in the RFP, in the 
Proposal Submission Instructions
 Instructions will include the location to 

which the proposal must be delivered 
and the due date and time of 
submission
 If hand-delivering the proposal to a 

local address, draw up a delivery receipt 
with the solicitation information, 
including RFP number and due date, 
and a place for the recipient to print 
his/her name and sign the receipt
• Learn in advance about security checkpoints or 

peculiarities of the building to which you’re making the 
delivery – ensure you know facility access procedures 
and allow ample time
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Preparing the Proposal for Shipping

 If you are shipping the proposal, it is wise to 
produce two sets of binders:

• One that is shipped several days before the 
deadline

• Second set which can be hand-carried to 
the customer site if something goes awry

 Use a box large enough to neatly fit all the 
binders

 Tape a printed copy of the shipping address or 
shipping label to the top of the box

 Always write RFP number on the box, and 
follow any additional instructions
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Summary and Recap
What have you learned?

 What are the attributes of a great 
DTPer?

 What are the different ways of 
navigating quickly through a document?

 What is the visual hierarchy?
 What is the most readable page layout?
 How do you fix a table of contents that 

is not displaying all of the outline 
headings?

 What is your biggest take-away from 
the class?
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Thank You for Attending!

David Huff
VP, BD and Operations

c: 513.316.0993
o: 301.769.6602

e: dhuff@ostglobalsolutions.com

Olessia Smotrova, CF. APMP, Fellow
President/CEO

c: 240.246.5305
o: 301.384.3350

e: otaylor@ostglobalsolutions.com

www.ostglobalsolutions.com

7361 Calhoun Place, Suite 560
Rockville, MD 20855

mailto:dhuff@ostglobalsolutions.com
mailto:otaylor@ostglobalsolutions.com
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